Solutions by Macnica Group

Reference Manual

Mpression Cyclone 10 LP Starter Kit

Revision 1.0

2017/12

o
RESSION
utions ica Group

Solut| by Ma

CCCCCCCC

http://www.m-pression.co

m



®
RESSION Mpression Cyclone 10 LP Starter Kit

Solutions by Macnica Group

© Mpression — Solutions by Macnica Group

Disclaimer

The information in this document (hereinafter called “Information”) is subject to change without notice.
Macnica Inc. (hereinafter called “Manufacturer”) makes no warranty of any kind regarding this document, or of
any liability arising out of the application or use of information in this document, and assumes no responsibility
for any errors that may appear in this document.

This document is distributed without any charge and reselling or copying without written authorization by

Manufacturer is restricted.

IN NO EVENT WILL MANUFACTURER BE LIABLE FOR ANY CONSEQUENTIAL, INDIRECT,
EXEMPLARY, SPECIAL, OR INCIDENTAL DAMAGES, INCLUDING ANY LOST DATA AND LOST
PROFITS, ARISING FROM OR RELATING TO YOUR USE OF THE INFORMATION, EVEN IF YOU HAVE
BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. THE TOTAL CUMULATIVE LIABILITY OF
MANUFACTURER IN CONNECTION WITH YOUR USE OF THE INFORMATION IN THIS DOCUMENT,
WHETHER IN CONTRACT OR TORT OR OTHERWISE, WILL IN NO EVENT EXCEED THE AMOUNT OF
FEES PAID BY YOU TO MANUFACTURER HEREUNDER FOR USE OF THE INFORMATION. YOU
ACKNOWLEDGE THAT THE FEES, IF ANY, REFLECT THE ALLOCATION OF RISK SET FORTH IN THIS
AGREEMENT AND THAT MANUFACTURER WOULD NOT MAKE AVAILABLE THE INFORMATION TO
YOU WITHOUT THESE LIMITATIONS OF LIABILITY.

The Information is not intended for use in the development of on-line control equipment in hazardous
environments requiring failsafe controls, such as in the operation of nuclear facilities, aircraft navigation or
communications systems, air traffic control, life support, or weapons systems (“High-Risk Applications”).
Manufacturer specifically disclaims any express or implied warranties of fitness for such High-Risk

Applications. You represent that use of the Information in such High-Risk Applications is fully at your risk.
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1. For Ensuring Safe Use

Be sure to follow the instructions given in this Manual which are intended to prevent harm to the
user and others as well as material damage.

1.1 Legend

Indicates an imminent hazardous situation which if not avoided will result in
& Danger

death or serious injury.

. Indicates a potentially hazardous situation which if not avoided could result in
& Warning

death or serious injury.

Indicates a potentially hazardous situation which if not avoided may result in
& Caution

minor or moderate injury or in property damage.

1.2 Cautions

Make sure to use the AC adapter (included in package) that is specified in this

Manual.
Danger . . . o
Using an AC adapter not meeting the specifications described in this Manual

will cause the kit to emit heat, explode, or ignite.

Do not apply strong impacts or blows to the kit.
Doing so may cause the kit to emit heat, explode, or ignite, or the equipment in

the kit to fail or malfunction. This may also cause fire.

Do not put the main unit or the AC adapter in cooking appliances such as
microwave ovens, or high-pressure containers.
Doing so might cause the main unit or AC adapter to emit heat, explode, ignite,

or emit smoke, or its parts to break or warp.

Do not wrap the main unit that is in use with cloth or other materials that are
likely to allow heat to build up inside the wrapping.

This will cause heat to build up inside the wrapping which may cause the main
unit to ignite or malfunction.

& Wa rning When disposing of the main unit, do not dispose of it along with general
household waste.

Throwing the main unit into fire may cause it to explode. Dispose of the
main unit following the laws, regulations, and ordinances governing
waste disposal.

Do not use the kit in places subject to extremely high or low temperatures or
severe temperature changes.

Doing so may cause the kit to fail or to malfunction.

Always be sure to use the kit in a temperatures ranging from 5°C to 35°C and a
humidity range of 0% to 85%.
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Do not pull the power supply cable with excessive force or place heavy items on
it.

Do not damage, break, bundle, or tamper with the power supply cable.
Damaged parts of the power supply cable might cause a short circuit resulting

in fire or accidents involving electrical shock.

Do not unplug the power plug with wet or moist hands.
This might cause injuries or equipment malfunctions or failures due to

electrical shock.

Plug the power plug securely into the outlet.
If the power plug is not securely plugged into the outlet, it may cause accidents

involving electrical shock or fire due to heat emitted.

Do not connect many electrical cords to a single socket or connect an AC adapter
Wa rning to an outlet that is not rated for the specified voltage.
& (Continued from | Failing to do so may cause the equipment to malfunction or fail, or lead to

previous page) accidents involving electrical shock or fire due to heat emitted.

Periodically remove any dust accumulated on the power plug and around the
outlet (socket).

Do not use a power plug with dust accumulated on it because doing so will lead
to insulation failure due to moisture which may lead to fire.

Remove any dust on the power plug and around the outlet with dried cloth.

Do not place any containers such as cups or vases filled with water or other
liquid on this Board.

If this Board is exposed to water or other liquids it may cause the Board to
malfunction or lead to accidents involving electrical shock. If you spilled water
or other liquid on this Board, immediately stop using the Board, turn off the
power, and unplug the power plug. If you have any requests for repairs or

technical consultation, please contact the Manufacturer.

Do not place the kit on unstable places such as shaky stands or tilted locations.
Doing so may cause injuries or cause this Board to malfunction if the Board
should fall.

Do not attempt to use or leave the kit in places subject to strong direct sunlight

or other places subject to high temperatures such as in cars in hot weather.
Doing so might cause the kit to emit heat, break, ignite, run out of control,
warp, or malfunction.

Also, some parts of the equipment might emit heat causing burn injuries.

Unplug the power supply cable when carrying out maintenance of devices in
which the main unit is embedded.

& Caution Failure to do so may lead to accidents involving electrical shock.

Do not place this Board in locations where excessive force is applied to the
Board.

Failure to do so may cause the PC board to warp, leading to breakage of the PC

board, missing parts or malfunctioning parts.

When using the kit together with expansion boards or other peripheral devices,
be sure to carefully read each of their manuals and to use them correctly.

Manufacturer does not guarantee the operation of specific expansion boards or
peripheral devices when used in conjunction with this Board unless they are

specifically mentioned in this Manual or their successful operation with this

Board has been confirmed in separate documents.
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Be sure to turn off the power switch when moving this Board to connect to other
devices.
Failure to do so may cause this Board to fail or lead to accidents involving

electrical shock.

Do not clean this Board by using a rag containing chemicals such as benzine or
thinner.
Failure to do so will likely to cause this Board to deteriorate. When using a

chemical cloth be sure to comply with any directions or warnings.

Do not immediately turn on the power if you find that water or moisture had
condensed onto the main unit after removing the board from the package.
Condensation might occur on this Board when taking it out of the box, if the
board is cool yet the room temperature is warm.

Caution Do not apply power to the Board while water or moisture has condensed on it
& because the moisture may cause the Board to break or may shorten the service

(Continued from
) life of the parts.
previous page)
When you first take this Board out of the box be sure to leave it at room
temperature for a while before using it. If condensation or moisture has
occurred on this Board, first wait for the moisture to fully evaporate before

installing or connecting the Board to other devices.

Do not disassemble, dismantle, modify, alter, or recycle parts unless they are
clearly described as customizable in this Manual.

Although this kit is customizable, if parts not specified in this Manual as
customizable are modified in any way, then the overall product operation
cannot be guaranteed.

Please consult with Manufacturer beforehand if you wish to customize or modify

any parts that are not described in this Manual as customizable.

1.3 Developer Information

The Developer of this product is:
Macnica Galaxy.

14F, 207-5, Sec. 3, Peihsin Rd., Hsintien Dist., New Taipei, Taiwan, R.O.C.

http://www.gfec.com.tw/

1.4 Inquiries

In case you have any inquiries about the use this product, please contact your local Macnica
company or make inquiries through the contact form in the following web site:
http://www.m-pression.com/contact

Macnica companies:

¢ (China & HK: Cytech Technology http://www.cytech.com/
e ASEAN & India: Cytech Global http://www.cytechglobal.com/
¢ Taiwan: Galaxy Far East Corp. http://www.gfec.com.tw/
¢ North America: Macnica Americas http://www.macnica-na.com/
* Brazil: Macnica DHW http://www.macnicadhw.com.br/en/
e Japan: Altima http://www.altima.co.jp
Elsena http://www.elsena.co.jp
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2. %% A

2.1 Content

® Altera Cyclone 10 LP Starter Kit
® Mini USB Power Cable

® USB Download Cable GEi#)

2.2 Attention

o EMFINAREENE, FHEZENERAESETE
o REINET /0 ERRZ HEEIES 3.3V BUE3R, EARIER IC (10CL010U256C8N), FTEIAN
SIEEEIL IC X BITIRIERIE

2.3 Feature

* 9 % A& ™ L Altera Cyclone 10 LP Device Family 37 ®{ skt > # & 8 i=%k 33 &}L—*‘ A
LERFREESFIRD L BR L F AP &K 25 FPGA 2 10CLO10U256C8N - IC #5:, S 10K LEs -
46 Block M9K memory » 18 x 18 Multiplier » 2 # PLL o 3FmehF & 047 1 Altera Web Sit 27
(http://www.altera.com) °

“# 7 10CLO10U256C8N iz4p IC 2 #F » ~F % m B F - L%f 7 2451 10CLO10U256C8N i+
T o F VR fapl B R A - B G

2.4 i¥if

8 Bits DIP Switch

4 Push Buttons

8 LEDs

1 Oscillator IC ( 100MHz > 50MHz > 24MHz )
2 Extension I/0 Connectors

4B TR

72 GPIO

2.5 Power Up

i Mini USB Power Cable &% JP16 , LED D11 =it

@@Iéiﬁ.

OK K R21 ERR R20POK RS9 ln!}
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2.6 HHEE

REEM EH A Intel Quartus Prime Lite Edition 17.0 2 &AYKAS #kEEE] £ Altera 48 E N&;
SRl 2 WG F P BR 1] 27 Quartus Prime Handbook

P4
2.7 ¥*F
EERHRAT » AEBRIRE 30 RAVREL
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3. B e 2 HmE A

3.1 *BELE

Push Button X 4 8 Bits DIP Switch

User LEDs
7 Segment
Glg—SEmB N : - T ST 10CL010YU256C8G
REV : A bié d ; . :
12305 N u“u‘:.:‘m - = - FPGA reconfig
38 6PI0 EL‘ ,,C ; Configure Flash
- S — - FPGA Configure Finish
o

R0 e

FPGA Configure Fail
Power LED

5VDC
Mini USB

34 GPIO

3.2 8 Bits DIP Switch (SW1)

* 9 % # & 8 bits DIP Switch »§ Switch *» 2 "ON”fF Cyclone 10 LP Device I/O #-% Low »2 ¢ 8 bits
DIP Switch i L4 %r{e Cyclone 10 LP Device 7 I/O # 27 %4 = %

FPGAIJTAG

xR 8 Bits DIP Switch
Switch i 5, DIP1 DIP2 DIP3 DIP 4 DIP 5 DIP 6 DIP 7 DIP 8
Cyclone 10 LP #%ri= R16 P15 P16 N16 113 M12 K12 L14

3 ON 5 Mm% OFF 5 3 ¥~
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3.3 Push Button (S1,S3, 52, S1)

*F %P 4B Pushbutton #4877 pt3estpd > #4% i Low 112 82% Cyclone 10 LP » 7 3% » L 3%
%ri#-Pull-High - # ¢ Push Button 7 5.4 %"{r Cyclone 10 LP Device 7 I/O B (27 %4 = %

£y 4 Push Button
Push Button £ S1 S3 S2 S4
Cyclone 10 LP #%ri= 116 K15 J11 J16

Fr R TR MR AR ER

3.4 LED (D1~D8)

% Cyclone 10 LP ¥ &) Low =iz 5.p% » LED #-3 4= »# ¢ 8 i LED 7 8.4 %r{r Cyclone 10 LP Device
SO M BT %F T 4 o

KE 8 LEDs
LED 5, D1 D2 D3 D4 D5 D6 D7 D8
Cyclone 10 LP #%ri= J15 J12 J13 D16 G16 F13 F15 B16

Her: mE-LED & > 3 # = LED 7 &
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3.5 = KB E

i - BETE
Segment pin g A B C D E

Cyclone 10 LP #%rix A2 A5 E8 D14 E6 D8 F10 F9

xR = BB R
Common pin * % DP1 DP2 DP3 DP4

Cyclone 10 LP #%ri= Fi11 D9 F7 D3

B 4 Commonpin 2 3 HpF> A7fahid - - KT F
+ Segment pin 5 M# =pF > 722 7- & LE

3.6 Clock

A E%FEHRE LR IDT e T R IC> ¢ IC W ﬁs?] 41 clock 24MH - 50MHz > 100MHz i#  Cyclone 10 LP
Device.

Clock 24 MHz 50 MHz 100 MHz

Cyclone 10 LP #%ri= Mil6 M15 E2

3.7 JP9 Vcc I/0 Voltage

AEHFERE2BVOH LR HE > 1P 5 & J/O Pin 7nVCC I/O 4.7 8 (3.3V or 1.8V ) - I/O Pin =»
ﬁi%]ﬂi?lfﬁﬁﬂé‘ L sk F» iz Pin 4 %4 Cyclone 10 LP Bank 2 > Bank 3 » Bank 4 > ¥ 3 % /& 0
Fli 1.8V >33V - 2T [/0 Bank £.H 75 VCCI/O» 7 & % 3.3V

JP9 16 U4
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3.8 Extension I/O Connectors(JP1, JP2)

Cyclone 10 LP # # - 4 I/O pin » + % S 4 % 1/0 284 4 u]i¢ 4 JP1 » JP2

» B B BARE 33V Ed AT LR RE

JP1 Cyclone 10 LP Pin JP1 Cyclone 10 LLP Pin
1(GND) 2(GND)
3 E16 4 Al3
5 E15 6 B13
7 Al2 8 All
9 B12 10 B11
11 Al10 12 A9
13 B10 14 B9
15 A8 16 A7
17 B8 18 B7
JP1 Cyclone 10 LP Pin JP1 Cyclone 10 LP Pin
19 A6 20 A4
21 B6 22 B4
23(GND) 24(GND)
25 B1 26 C2
27 D4 28 F5
29 D1 30 F3
31 G2 32 J1
33 K2 34 K1
35 L2 36 K6
37 L4 38 L3
39 N2 40 N1
41 P1 42 R1
43(GND) 44(GND)
JP2 Cyclone 10 LP Pin JP2 Cyclone 10 LLP Pin
1(5V Power input) 2(5V Power input)
3(GND) 4(GND)
5 L10 6 T15
7 M10 8 P14
9 L9 10 R13
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11 N11 12 T12
13 N9 14 R12
15 K9 16 T11
17 K8 18 P11
19 L8 20 T10
21(GND) 22(GND)
23 Ms8 24 R10
25 L7 26 R9
27 P6 28 N8
29 N5 30 R7
31 M6 32 R6
33 R4 34 R5
35 P3 36 T3
JP2 Cyclone 10 LP Pin JP2 Cyclone 10 LP Pin
37 N3 38 T2
39 M2 40 M1
41(GND) 42(GND)
3.9 Power

AREFCGEPEDTRAESE S LIRS T I * AR % 74k &0 Mini USB Cable ® 4#%4& » JP16

?’gﬁﬁiﬁﬁ»%’IEDDH@Om%kﬁ%ko

b Ha v JP2 ﬁis?] a1 'R RGBV) > £ & # JP8 5| PIN(JP2 9 Pin 1~ 2> 5 EXT Power

mﬁ?—l »> Pin)

© Mpression by Macnica Group
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3.10 JTAG Connector

Altera Cyclone 10 LP Device § # # ISP (In System Programming) =il » &7 *: -k = 7 e USB
DownLoad Cable > - #3317 "6 USB# » ¥ - #4663 J2> £ 1% Altera & * ## Quartus Prime -
TEHRFTHT LI AT R

3.11 Status LED

D10 : FPGA Configure Finish
D9  : Configure Fail
D11 :Power LED
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4, F > 37Nk K, AR T 2 7 FPGA

1. #® Quartus II prime Lite Edition

File Edt Viw Project Assigments Procesiing Tocls Window selp

L]
8] ol O
[ v— e
 Compiaton Hemreny . Cyelone v IEIGX/GTISHSEIST) =
Recent Projects

X =
B use.oLop (G

o
B o caieape

use.

PDE@ & v

e 10 message

88 rina.. | (88 roanen|

)

essage

o Y

2. File -> New Project Wizard

File | Edit View Project Assignments Processing Tools Window Melp

] New. crlen l v ESH DrrEOQAVE @
s
e S ‘ Home
Close CirlsF4
New Project Wiz Recent Projects
Cut-J USB_DLqpT (G/Cycione 10_pojjusb_di_max
test_prp.qpf (G /Cyclone 10
DI_CABLE.qpS |
H swe e USB_DLGpr (G /C
o Cirl+Shiftss
File Properties
Create { Update » e
Convert Programming Files... Documentatior
dl PageSetup..
@ Pt Preview
W Print. Cud+p
Recent Files ’
Recent Projects »
Exit AlteFa

< M »

—— [y
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Introduction

The New Project Wizard helps you create a new project and preliminary project settings, including the following:

Project name and directory

Name of the top-level design entity

Project files and libraries

Target device family and device

EDA tool settings
You can change the settings for an existing project and specify additional project-wide settings with the Settings command (Assignments
menu). You can use the vanous pages of the Settings dialog box to add functionality to the project

Don't show me this Introduction again

i | [cancel | [ o]

e
4 ERLFREA G B F L

1

Comgi

G:/Cyclone_10_poj/test_program/TEST_PRG1

What is the name of this project?

What is the name of the top-level design entity for this project? This name is case sensitive and must exactly match the entity name in the
design file

|Use Existing Project Settings ..

Reference Manual - Mpression Cyclone 10 LP Starter Kit
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5. Empty project -> Next

yne_10_poj/usb_di_max5_ver2_17/USB_DL qpf

Project Type

Select the type of project to create.

© Empty project
Create new project by specifying project files and libraries, target device family and device, and EDA tool settings.
Project template

Create a project from an existing design template. You can choose from design templates installed with the Quartus Prime software, or
download design templates from the Design Store.

[ Finish J [ Cancel ]l Help I

[ P |

6. 4c B X afrNaE

Add Files

Select the design files you want to include in the project. Click Add All to add all design files in the project directory to the project
Note: you can always add design files to the project Later.

File name:

o Type Libary Design Entry/Synthesis Tool HDL Version = ‘vad

VH. Defauls.
Select File

& )>[] > 5= » THEZ(G) » Cylone 10.00] » testprogram » TESTPRGL
BaEEv  FARSR

m2E < z
H ®EneE

S i

%) X%

Specify the path names of any non-default libraries. [Usev Libr:ré |

) & zmss)
s Windows 7 (D)
s OS disk (€9
< Datadisk (F)
o SHERG)

|88 Fing next|

.« i
o mee !

EZEEN):
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7. #4# Cyclone 10 LP IC %)% (10CL010YU256CS8G)

3 Family, Device & Board Settings
Device Board
Select the family and device you want to target for compilation.
You can install additional device support with the Install Devices command on the Tools menu,
| To determine the version of the Quartus Prime software in which your target device is supported, refer to the Device Support List webpage.
Comfy Device family Show in "Available devices’ list
t Package:
% Pin count:
Target device Core speed grad' |8
Auto device selected by the Fitter Name fitter:
@ specific device selected in ‘Available devices' list Show advanced devices
Available devices:
Name Core Voltage LEs Total 1/Os GPIOs Memory Bits bedded multiplier 9-bit el
6272 177 177 276430 30
T T
15408 163 163 516096 112
10CLO25YU256C8G 1.2V 24624 15 151 808256 132
« m ’
L

I < Back H Next > Finish Cancel [ Help -

8. Next

EDA Tool Settings

Specify the other EDA tools used with the Quartus Prime software to develop your project.

EDA toals:

Tool Name Formatis) Run Tool Automatically

esign Entry/Synih._.{| shone> Run this tool autsmat

Comid | simulation <Nones <None= - [ Run

wel sirr tion auto:
Board-Level Tirming :N_un:b v]
Symbol <Nones -
Signal Integrity <Nonex i
Boundary Scan <=None> &

Ll

[ < Back Finich : Cancel ][ Help
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e_10_poj/usb_di

= Summary
When you click Finish, the project will be created with the following settings
Project directory Gi/Cyclone_10_poi/test_program/TEST_PRG1
Project name. TEST_PRG
Top-level design entity: TEST_PRG
Comfl|  Number of files added: 1
Number of user libraries added 0
Device assignments
Design template: nfa
Family name: Cyclone 10 LP
Device: 10CLO10YU256C3G
Board: nia
EDA tools:
Design entry/synthesis: <None> (<None>}
Simulation <None> (<None>)
Timing analysis: 0
Operating conditions:
VCCINT voltage: 12v
Junction temperature range: 0-85°C
ey SRS _

<Back neas ([ _einsh 1) cancet [ nep | [F

10. Start Analysis & Synthesis

File Edt View Project Assignments Processing Tools Window Help

Nrsd D C | |resrers '1’66'&":»@0&@@.

Pm‘ect?hviﬁatnll \ Hierarchy rjame || ¢ ]
1
N g QCLO10YU256C8G 2 use _1164.ALL;
3 USE iee Togic_unsigned. all;
4 --USE WORK.my_package. ALL;
S LIBRARY ALTERA;
6 USE ALTERA.MAXPLUS2.ALL;
7
ENTITY test_prg Is
PORT(
CLK_50MKz m
CLK 28wz ™
CLK100mHz wn
out
DIP_SW D IN
PB_SW DN
LED_DISPLAY OGIC_VECTOR(7 DOWNTO 0);
LED_DISPLAY_CON GIC_VECTOR(3 DOWNTO 0}
EXT1_IO @ ouT STD_LOGIC_VECTOR(33 downto 0);
EXTLZCLK_OUT ©
ZcLK_INL
EXTIZCLK_0UT1
L
EXT2_T0
EXT2_CLK_OUT
EXT2_CLK_INL
EXT2_CLK_0uT1
1 EXT2.CLK
Tasks [ complanon ~|=mes x|
Task | = %
4 P Compile Design PR Yo testpra;
P Analysis & Synthesis ARCHITECTURE a OF Test_prg IS
P Fitter (Place & Route)
P Assembler (Generate programmin| IO SVEIEER
SIGNAL RESETN
P TimeQuest Timing Analysis STGNAL RESET CNT 203
P EDA Netst writer SIGNAL CLK_D
4 SIGNAL CNTD
B o setngs | & SIGNAL LED_REG
@ program Device (Open Programme) || 3 SIGNAL C
5: SIGNAL CNTI
5 SIGNAL EXT1_REG
|| 5
i ik i
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11. % = Analysis & Synthesis

"\ Quartus Prime Lits ESIBN= G/ Cyclons 10_poj/testiprogramyIES1_PRGIJIES|_PRG - IESIFRG T T T "

File Edit View Project Assignments Processing Tools Window Help
1 H r TEST_PRG S Or S OAVE S
Project szlguorl\ 4\ Hierarchy v]f‘«(})s x| ¢ test_prg.vhd 0l e Compilation Report - TEST_PR
Entitynstance ||Table of Contents m=
A\ Cyclone 10 LP; 10CLOT0YU256C8G &8 Flow Summary o
BB test_pre B E= Flow Settngs Flow Status Successful - Thu Oct 12 14:02:37 2017
B2 Flow Non-Default Global Settings Quartus Prime Version 17.0.0 Build 595 04/25/2017 SJ Lite Edition
BB Flow Elapsed Time Revision Name TEST_PRG
B2 Flow 05 Summary Top-level Entity Name test_prg
= FlowLog Family Cyclone 10 LP
-] Analysis & Synthesis Device 10CLOTOYU256C8G
O Flow Messages Timing Models Final
© Flow Suppressed Messages Total logic elements 263
Total registers 148
Total pins 107
| Total virtual pins o
« i v
X Total memory bits 0
[Tasks Compilation Embedded Multiplier 9-bit elements 0
Task 4| Total PLLs 0
=
P Assembler (Generate programr
P TimeQuest Timing Analysis
P EDA Netiist Writer
B Foit Sertines ¥ i
« m » < | VF | ’
x o =
s (2] @ &) (4] (A ¥ <<rieen [ 88 Finc... | 88 Find Next
@
= | Type ID Message
o e T T T T T T T T P T T e P T e T e P
) Running Quartus Prime Analysis & Synthesis
o Command: quartus_map read_settings_files-on --write_settings_files=-off TEST_PRG -C TEST_PRG

12. % %_Cyclone 10 LP % %riz  (Assignments -> Pin Planner)
£ oiRypR * L P 3-8 9 pin#E i Location

vansuy
Node Name

Cyclone TOLP - 10CLOTOYUZ256C(8G

Directio

<<New..oup>>

< >

Groups Report

rasks L

I Early Pin Planning ~
W Early Pin Plann
P> Run I/O Assigl

W Export Pin Assi

P DEDH /ALK O g
2 9/ EONNRONDRDO\V/D
T AUV D ROV L

< >

M Named:: ~| «» Edit; % .

= Node Name Direction i I/O Bank /REF Group 'O Standare Reserved -TentStren; SlewRate fferential P: ct Preserva
L3 'PB75W[3] Unknown B5_NO 2.5 V..ault) 8maA ...ult)
© PB_SW[2] 5 B5_NO 2.5 V...ault) 8mA ...ult)
© PB_SW[1] 5 B5_NO 2.5V..ault) 8mA _..ult)
© PB_SW[0] 5 B5_NO 2.5V..ault) 8mA _..ult)
© LED_D..ON[3] 7 B7_NO 2.5V..ault) 8mA __.ult)
© LED_D..ON[2] 7 B7_NO 2.5 V...ault) 8mA ...ult)
© LED_D..ON[1] 8 B8_NO 2.5 V...ault) 8mA ...ult)
© LED_D..ON[0] 8 B8_NO 2.5V...ault) 8mA ...ult)
© LED_D..AY[7] 7 B7_NO 2.5V..ault) 8mA _..ult)
© LED_D..AY[6] 7 B7_NO 2.5V..ault) 8mA _.ult)
© LED_D..AY[5] 8 B8 NO 2.5V..ault) 8mA _.ult)
© LED_D..AY[4] 8 B8_NO 2.5 V...aulg) 8mA ...ult)
© LED_D..AY[3] 7 B7_NO 2.5 V...ault) 8mA...ult)
© LED_D..AY[2] Unknown 8, B8_NO 2.5 V..ault) 8mA ...ult)

E © LED_D..AY[1] Unknown B8_NO 2.5 V..ault) 8mA ...ult)

; © LED_D..AY[0] Unknown B8_NO 2.5 V...ault) 8mA ...ult)

<
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13. #2.;% %3 (Processing -> Start Compilation

S Quartus Prime Standard Edition - H/C10_LP/test_prg/test_prg - test_prg
File Edit View Project Assignments Processing Tools Window Help

s | € 20 |estpg @ StopProcessing Curl+Shift+C

Project Navigator  Hierarchy Cul+L
Entity-Instance L
i Cyclone 10 LP: 10CLOT0YU256C8G. Start 2
> test_prg® Update Memory Initialization File
4 Compilation Report Ctrl+R
@ Dynamic Synthesis Report
/ PowerPlay Power Analyzer Tool
# SSN Analyzer Tool

Receive Compilation Status Notifications

Tasks Compilation vsass

Task

v B Compile Design
> B Analysis & Synthesis
> P> Fitter (Place & Route)
> B Assembler (Generate program
> B TimeQuest Timing Analysis

<
gl (o] [&1[& @& v <<Filter> BBFind.. 8 Find Next
=

fvne TR Mes<ane

Quartus Prime

= [=] X
|Search altera.cor L
1P Catalog wen
. x|5

v & Installed IP
v Project Directory

No tion Available
~ Libras
> Basic Functions
> DSP

> Interface Protocols
> Memory Interfaces and Controllers
> Processorsand Peripherals
> Synaptic Labs
> System
> University Program
© Search for Partner IP

+ Add...

£ system  Processing
Starts a new compilation

a Quartus Prime Standard Edition - H:/C10_LP/test_prg/test_prg - test_prg

File Edit View Project Assignments Processing Tools Window Help

OrF | 0| D C||test_prg Sl DrFED A0 E 9
lams <|| @

Table of Contents

Project Navigawr{ v Hierarchy Compilation Report - test_prg

Entity:lnstance
E2 Flow Summary

& <<Filter>>

# Cyclone 10 LP: 10CLO10YU256C8G

test_prg @ FH Flow Settings

Flow Status
EH Flow Non-Default Global ¢ | Quartus Prime Version
B Flow Elapsed Time Revision Name

EH Flow OS Summary Top-level Entity Name

E FlowLog Family
> B Analysis & Synthesis Device
> = Fitter

Timing Models
0 Flow Messages Total logic elements

© Flow Suppressed Message | Total registers

Tasks ‘Compilation > W Assembler Total pins

Task ~ > M TimeQuest Timing Analyz| | Total virtual pins

Total memory bits

¥ ¥ W Compile Design Embedded Multiplier 9-bit elefgents 0/ 46 (0 %)
v > P> Analysis & Synthesis Total PLLS
v > P> Fitter (Place & Route)
v > B> Assembler (Generate programmn
v > P> TimeQuest Timing Analysis v
< > < >

Successful - Mon Dec 11 11:30:30 2017
Q4/25/2017 SJ Standard Edition

test_prg
Cyclone 10 LP

10CLOT0YU256C8G
Final
348/10,320(3 %)
210
107 /177 (60 %)
0
0/423,936 (0 %)

0/2(0%)
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15. Configure FPGA
A. Tool->programmer
B. B5# Add File 3:FT5d sof file
C. W TEFE Program/Configure 1]

& Hardware Setup... |USB-Blaster [USB-0] Mode: |JTAG <

[] Enable real-time ISP to allow background programming when available

b Start File Device ‘hecksun Jsercode Program/ ferify 3lank- xamine securit Zrase ISP
Configure “heck Bit LAMI
' Stop output files/test_prg.sof  10CLO10Y.. OOOBE.. OOOBE... [v
y Auto Dete
% Delete
™ Add File.
Change Fil

2 Save File b

Add Devic 1ocLotovu2sEe

% Up

" Down

D. 1 LEFAREEE USB Download Cable ffiZ# PC,55—fiE J2 ,Hardware Setup #EE
USB Blaster[USB-11, k1% FiBhi5 Start, B[ A]FHtA S
E. 85585 LED D10 et
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Mpression Cyclone 10 LP Starter Kit

RESSION

Solutions by Macnica Group

5. #& ¢ sof to jic

ARG R - F R S8 n.SOF 4 0 v 4 5 ¥ 8T Flash chfh % > ©7 e

%473 Flash
1. File -> Convert Programming File

ANl

Programming file type ,7#$% JTAG Indirect Configuration File (jic)
1E Configuration device, ##E EPCS128
1£ File name, #55€ directory il output file name.

0|

2k Advanced.. , # Disable EPCS/EPCQ ID check ¥]4)

WY Advanced Options X

.Disable EPCS/EPCQ ID check
[m] Disable AS mode CONF_DONE error check

Program length count adjustment:
Post-chain bitstream pad bytes:
Post-device bitstream pad bytes:

Bitslice padding value:

1 -

© XN

QSPI Flash single 10 mode dummy clock: Unchangeable

QSPI Flash quad 10 mode dummy clock: Unchangeable

1£ Input files to convert window ,Highlight the SOF Data
Ehi5E Add File. i SR sof file

WA .sof file that you want to convert to a .jic file.
Highlight Flash Loader F#L#%E Add Device.

. £ Select Devices #7#5, Device Family %52 Cyclone 10 LP ,Device Name #:#2 10CL010Y

FEEE OK

11. 12%L%EE Generate

17 Convert Programming File - Hi/C10_LP/test_prg/test_prg - test_prg

- =] X
File Tools Window ®
~
Specify the input files to convert and the type of programming file to generate
You can also importinput file information from other files and save the conversion setup information created here for
future use.
Conversion setup files
Open Conversion Setup Data. Save Conversion Setup..
Output programming file
Programming file type |JTAG Indirect Configuration File (jic) I -
Options/Boot info... Configuration device: EPC5128 ~ Mode: Active Serial -
Advanced RemotejLocal update difference file: NONE
Create Memory Map File (Generate output_file.map)
™
[[] create config data RPD (Generate output_file_auto.rpd)
Input files to convert
File/Data area Properties tart Addres Add Hex Data
Flash Loader add Sof Page
10C1L010
v EOF Data Page 0 <auto> Add File
test_prg.sof 10CLO10YU256
De
Prog
B G v

© Mpression by Macnica Group

Reference Manual - Mpression Cyclone 10 LP Starter Kit




®
RESSION Mpression Cyclone 10 LP Starter Kit

Solutions by Macnica Group

6. 4 i #-jic file T i‘fr_ Serial Flash

2. Tool->programmer
3. ERE Add File iA6$TH jic file
4. W TEAT R Program/Configure $17)

© Programmer - Gi/Cyclone_10_poj/test_program/TEST PRGI/TEST PRG - TEGT PHG - [TEGT PRG cdi® JE=REe
File Edt View Processing Tools Window Help

(
;; Hardware Setup...| USB-Blaster [USB-1] Mode:  JTAG \4 Progress.

Enable real-time ISP to allow background programming when available

p File Device Checksum Usercode Program/ Verfy  EBlank- Examine Secunty Erase sP
@ Check - CLAMP

Factory default enhanc.. 10CLOTOY 000CFF50  OQOCFFS0
[ “ Auto " output_files/output. EPCQI28 ForoBCES
L
—
| X Delete
| ™ AddFile
|P** change File
. J'. Add Device...

5. W LEFfREEE USB Download Cable ##%E PC,52—IfHE J2 ,Hardware Setup #:#% USB
Blaster[USB-1],241% FBi5E Start, B A] 4G EH%

6. BLJ7AESHE Flash #EfTHESRE FrLlEEsRseie R B BB A% — S5,%F LED D10 5zl =R
B4 EHY image configure ] FPGA

.ur
LA )
1234567090 12}
A
8-
D

£
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